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You	can	use	the	custom	formula	function	in	Google	Sheets	to	apply	conditional	formatting	based	on	the	value	of	a	checkbox.	The	following	example	shows	how	to	use	the	custom	formula	function	in	practice.	Example:	Conditional	Formatting	Based	on	Checkbox	Suppose	we	have	the	following	dataset	in	Google	Sheets	that	shows	whether	various
basketball	teams	made	the	playoffs:	Suppose	we’d	like	to	highlight	each	of	the	cells	in	the	Team	column	where	the	corresponding	checkbox	in	the	Made	Playoffs	column	is	checked.	To	do	so,	we	can	highlight	the	cells	in	the	range	A2:A11,	then	click	the	Format	tab,	then	click	Conditional	formatting:	In	the	Conditional	format	rules	panel	that	appears	on
the	right	side	of	the	screen,	click	the	Format	cells	if	dropdown,	then	choose	Custom	formula	is,	then	type	in	the	following	formula:	=B2=TRUE	Note:	It’s	important	that	you	include	the	equal	sign	(=)	at	the	beginning	of	the	formula,	otherwise	the	conditional	formatting	won’t	work.	Once	you	click	Done,	each	of	the	cells	in	the	Team	column	where	the
checkbox	is	checked	in	the	Made	Playoffs	column	will	be	highlighted	with	a	green	background:	The	only	Team	values	that	have	a	green	background	are	the	ones	where	the	checkbox	in	the	Made	Playoffs	column	is	checked.	Note	that	you	can	choose	a	different	background	color	as	well	within	the	Conditional	format	rules	panel.	Green	is	simply	the
default.	Additional	Resources	The	following	tutorials	explain	how	to	perform	other	common	tasks	in	Google	Sheets:	Google	Sheets:	Conditional	Formatting	If	Date	is	Before	Today	Google	Sheets:	Conditional	Formatting	with	Multiple	Conditions	Google	Sheets:	Conditional	Formatting	if	Another	Cell	Contains	Text	Learn	how	to	use	conditional
formatting	in	Google	Sheets.	This	guide	covers	everything	from	setting	basic	formatting	rules	based	on	numbers,	text,	dates,	and	other	cell	values,	to	using	custom	formulas	for	cases	like	deadlines	or	specific	values.	By	setting	up	format	rules	tailored	to	your	unique	needs,	you’ll	save	time,	reduce	errors,	and	make	the	most	important	details	stand	out.
Highlighting	specific	data	with	color	is	a	great	way	to	emphasize	key	information	—	many	of	us	do	this	all	the	time.	But	if	you	have	data	that	changes	frequently,	like	values	that	rise	or	fall	above	a	certain	number,	or	cells	containing	particular	keywords,	manually	formatting	each	cell	can	be	time-consuming	and	prone	to	errors.	Wouldn't	it	be	great	if
such	changes	to	formatting	occurred	automatically?	Conditional	formatting	in	Google	Sheets	does	just	that.	It	automatically	updates	cell	colors	based	on	rules	you	set	so	that	important	cells	stand	out	immediately.	Let’s	explore	some	examples	so	you	see	how	easily	Google	Sheets	can	apply	and	adjust	formats	based	on	data	in	real-time.	Whatever
conditional	formatting	rule	you'd	like	to	add	in	Google	Sheets,	it	all	starts	the	same	—	with	a	few	clicks:	Select	the	cells	you	want	to	apply	the	rule	to.	Go	to	Format	>	Conditional	formatting	in	the	Google	Sheets	menu:	A	panel	will	appear	on	the	right	side	of	the	screen	where	you’ll	set	the	details	of	the	rule:	edit	the	range	to	apply	the	rule	to	if	needed
set	up	the	condition	that	best	fits	your	needs	choose	how	you	want	the	cells	to	look	like	when	the	rule	is	met:	set	a	background	color	or/and	font	color;	make	the	text	bold,	italic,	underlined	or	strikethrough.	Once	everything's	set,	click	Done	to	save	the	rule.	You	can	add	more	rules	by	clicking	Add	another	rule	on	the	same	pane.	And	you	can	easily
modify	or	remove	existing	rules	anytime:	With	this	general	setup,	you’re	ready	to	create	specific	formatting	rules	for	various	use	cases.	Let’s	jump	right	in	?	Conditional	formatting	in	Google	Sheets	is	a	fantastic	way	to	visually	highlight	numerical	data	based	on	specific	values.	So	let's	suppose	you	want	to	color	orders	greater	than	$200	in	total	sales
(column	F):	Select	column	F	(a	column	with	your	numbers).	Go	to	Format	>	Conditional	formatting.	Choose	a	condition	from	the	dropdown	menu:	Greater	than	or	equal	to,	and	enter	200	in	the	provided	field:	Set	the	formatting	style	you	prefer.	For	instance,	use	bold	red	text	on	a	yellow	fill	color	to	make	the	cells	stand	out:	The	style	will	be
immediately	applied	to	all	cells	meeting	your	condition:	they	all	change	colors	accordingly.	As	an	alternative,	for	a	more	nuanced	visualization,	you	can	use	a	color	scale:	In	the	Conditional	format	rules	sidebar,	switch	to	the	Color	scale	tab.	Pick	one	of	the	existing	sets	of	colors.	Or	customize	colors	for	the	minimum,	maximum	and	(optionally)	midpoint
values.	For	example,	set	light	green	for	the	smallest	numbers	and	dark	green	for	the	largest	so	that	cells	gradually	darken	as	values	increase:	These	are	simple	yet	effective	ways	to	draw	attention	to	numerical	patterns	in	your	data	?	In	some	cases,	you	may	want	to	apply	different	formats	based	on	different	conditions	to	the	cells	in	the	same	column.
Let's	say	you	need	to	color	orders	over	$200	in	green	and	orders	under	$100	in	red	to	draw	attention	to	these	specific	amounts.	If	color	scale	is	not	your	best	bet,	you	can	try	creating	several	formatting	rules,	each	specific	to	one	criterion:	Greater	than	or	equal	to	200.	Less	than	or	equal	to	100.	All	your	rules	will	be	applied	at	the	same	time.	Thus,
multiple	rules	let	you	create	a	more	tailored	view	of	your	data,	spot	key	patterns	and	take	action	accordingly.	While	Google	Sheets	offers	standard	options	to	format	cells,	they	may	sometimes	fall	short	of	covering	specific	or	complex	cases	where	a	custom	approach	is	needed.	That’s	why	there's	this	option	to	use	custom	formulas	as	conditions.	Custom
formulas	let	you	build	your	own	rules	using	standard	functions	and	operators.	You'll	be	able	to	specify	whether	a	cell	meets	a	particular	condition.	The	result	of	the	formula	should	be	either	TRUE	or	FALSE	—	if	TRUE,	the	formatting	will	be	applied.	To	get	started,	choose	Custom	formula	is	from	the	drop-down	menu	in	the	Conditional	format	sidebar:
Let	me	cover	some	useful	examples	so	you	see	how	this	can	work,	from	highlighting	the	highest	values	to	marking	minimum	values	while	excluding	zeros.	To	color	only	the	max	number	in	a	range,	use	this	custom	formula	in	conditional	formatting	in	Google	Sheets:	=F2=MAX($F$2:$F$50)	It	checks	if	each	cell	in	the	range	is	equal	to	the	maximum
value	and	applies	formatting	accordingly:	If	you	want	to	color	the	top	three	(or	other	N)	values	in	a	range,	create	as	many	formatting	rules	as	you	need	values,	with	the	following	custom	formulas	for	each	position:	=F2=LARGE($F$2:$F$50,	2)	you	will	need	to	replace	1	with	2,	3,	etc.	for	each	next	value	you'd	like	to	color:	To	highlight	the	lowest
number	in	a	range,	use	the	MIN	function	in	your	custom	formula:	=F2=MIN($F$2:$F$50)	If	you	prefer	don't	count	on	zeros	as	lowest	values,	use	MIN	along	with	FILTER	to	exclude	zeros	and	color	the	actual	minimum	value:	=F2=MIN(FILTER($F$2:$F$50,	$F$2:$F$50>0))	For	cases	where	you	need	to	highlight	N	lowest	numbers,	use	the	SMALL
function	indicating	the	position	of	the	number	(1st	or	2nd	small,	etc):	=F2=SMALL($F$2:$F$50,	1)	As	you	can	see,	custom	formulas	add	flexibility	to	conditional	formatting	in	Google	Sheets.	I’ll	return	to	them	often	throughout	this	article	to	solve	other	specific	formatting	cases!	To	conditionally	format	cells	with	text	in	Google	Sheets,	use	the	related
rule:	Text	contains	In	addition	to	just	entering	the	word	itself,	you	can	incorporate	wildcard	characters	to	enable	broader	pattern	matching	for	the	search:	Asterisk	(*)	matches	any	number	of	characters.	Thus,	d*	pattern	will	find	dark	chocolates.	Question	mark	(?)	matches	exactly	one	character.	Thus,	d???	pattern	will	find	dark	chocolates.	Tip.	To	find
the	actual	asterisks	and	question	marks	in	your	cells,	add	a	tilde	(~)	right	before	them.	For	example,	Dark~?	will	look	for	cell	that	actualy	contain	string	Dark?	Custom	formulas	with	REGEXMATCH	will	also	be	a	good	fit	here	for	highly	specific	searches:	=REGEXMATCH(D2:D50,"Dark")	Managing	deadlines	or	tracking	orders	is	yet	another	task	you
can	cover	with	conditional	formatting.	Google	Sheets	lets	you	set	up	custom	rules	to	highlight	dates	within	specific	time	frames	or	to	signal	when	deadlines	have	passed.	Let's	highlight	those	arrival	dates	that	are	expected	to	happen	within	the	next	7	days.	The	arrival	dates	are	in	column	G.	If	you	break	down	the	logic,	you	will	need	to	check	that	the
date	in	column	G	is	either	today	or	within	the	next	7	days.	This	custom	formula	will	do	the	trick:	=AND(G2>=TODAY(),	G2=DATE(2024,11,25),	G2	Conditional	formatting.	On	the	sidebar	that	appears,	you'll	see	all	the	rules	applied	to	the	range.	Hover	over	the	rule	you	want	to	remove	and	click	the	trash	icon.	This	will	delete	that	specific	rule	without
affecting	other	rules	or	formats.	With	all	these	tips	in	mind,	Google	Sheets	conditional	formatting	will	play	a	key	role	in	managing	your	data.	From	highlighting	values,	dates,	and	text	patterns	to	setting	up	adaptable	rules	with	custom	formulas,	you	will	bring	clarity	to	your	data.	Now	you’re	ready	to	bring	your	data	to	life	in	Google	Sheets!	?	How	can
you	apply	conditional	formatting	on	checkbox	cells	in	Google	Sheets?Conditional	formatting	in	Google	Sheets	can	be	applied	to	a	range	of	checkboxes	by	applying	the	conditional	formatting	condition	of	Is	equal	to	to	TRUE.Here’s	an	example	demonstrating	how	to	set	a	conditional	format	on	checkboxes.Create	Checkbox	Range#To	create	a	range	of
checkboxes,	select	your	range	and	then	click	on	the	Data	Validation	menu	item.Here	I	am	using	the	compressed	toolbar	view,	which	allows	me	to	type	the	menu	item	I	want	into	the	search	bar	and	then	select	it	with	one	click,	as	seen	below:From	the	Data	Validation	modal	window	you	need	to	select	the	Criteria	drop	down	menu	and	select
Checkbox.Upon	clicking	the	Save	button	you	should	small	individual	checkboxes	in	each	cell	of	the	range	you	selected,	as	seen	below:To	apply	conditional	formatting	to	these	cells	with	checkboxes	navigate	to	the	Conditional	Formatting	menu	item,	here	I	use	the	search	menu	and	enter	Conditional	to	have	the	menu	item	come	up:In	the	Format	Rules
area	change	the	Format	cells	if…	drop	down	field	to	Is	equal	to	and	in	the	corresponding	field	underneath	set	the	value	to	TRUE,	like	so:As	you	can	see	when	selecting	a	checkbox	in	the	range	where	the	Conditional	Formatting	applies	the	background	color	changes	to	the	format	set.You	can	apply	the	same	method	for	highlighting	a	cell	when	the
checkbox	is	NOT	ticked.	If	this	is	your	use	case,	then	change	the	value	in	the	format	rule	from	TRUE	to	FALSE.Then	when	a	cell	isn’t	ticked	it	will	highlight	according	to	the	format	selected.Highlight	Row	With	Checkbox	Ticked#If	you	wanted	to	extend	your	skillset	to	incorporate	having	a	whole	row	highlighted	when	a	range	containing	checkboxes	is
ticked,	then	you	can	change	your	conditional	format	to	use	custom	formulas.Running	with	the	same	example	above	if	you	wanted	to	highlight	the	complete	row	you	first	need	to	highlight	everything	on	the	active	sheet,	and	then	you	would	need	to	navigate	to	the	Conditional	Formatting	menu	item,	add	a	new	rule	and	in	the	Format	Rules	section	select
Custom	formula	is	and	then	enter	the	following	formula:=INDIRECT("A"&ROW(INDIRECT("RC",FALSE)))Here’s	what	this	looks	like:As	you	can	see	from	the	result	above	the	entire	first	row	is	highlighted	because	the	custom	formula	inspects	the	contents	in	column	A	and	if	it	is	TRUE	highlights	all	cells	in	that	row.As	the	checkbox	range	is	located	in	a
column	–	"A"	by	capturing	the	active	row	using	ROW(INDIRECT("RC",	FALSE))	and	wrapping	both	together	with	INDIRECT("A",	ROW(INDIRECT("RC",	FALSE)))	each	cell	references	the	location	of	the	checkbox	change	in	column	A	and	if	it	is	TRUE	then	allows	for	the	conditional	formatting	to	occur.If	you	wanted	the	inverse	where	cells	that	aren’t
ticked	need	to	be	highlighted,	then	all	you	would	simply	need	to	do	is	to	wrap	your	formula	with	the	NOT()	function,	like	so:=NOT(INDIRECT("A"&ROW(INDIRECT("RC",FALSE))))To	apply	conditional	formatting	to	cells	with	checkboxes	simply	use	the	rule	Is	equal	to	and	set	the	field	to	TRUE.Then	apply	the	necessary	format	you	want	to	display	and
whenever	the	checkbox	is	ticked	it	will	display	the	chosen	format.If	you	want	to	display	a	format	for	when	the	checkbox	is	NOT	ticked	then	change	the	field	from	TRUE	to	FALSE.Also,	if	you	want	to	highlight	a	complete	row	when	the	checkbox	in	a	columnar	range	isn’t	ticked,	you	can	use	the	formula	INDIRECT("A"&ROW(INDIRECT("RC",FALSE)))	as
a	custom	formula	conditional	format	if	your	checkbox	range	is	located	in	column	A,	otherwise,	change	the	"A"	to	suit	your	checkbox	column.	google-sheets	google-sheets-ui	conditional-formatting	Last	updated:	February	09,	2025	You	can	use	checkboxes	to	make	your	Google	Sheets	spreadsheet	interactive.	For	example,	in	this	tutorial,	you'll	learn	how
to	build	a	simple	To	Do	list	application		in	your	spreadsheet	by	using	checkboxes	and	conditional	formatting.	Your	browser	does	not	support	HTML5	video.	Here	is	a	link	to	the	video	instead.	Another	common	use	case	for	checkboxes	in	Google	Sheets	is	making	it	easy	for	users	to	select	specific	rows	to	be	processed	by	a	Google	Apps	Script	script.	For
example,	consider	the	following	table	containing	information	about	employees.1Take	action?First	nameLast	nameDepartment2BenRamFinance3JaneRyanFinance4AprilMadisonMarketing5JakeWoodSales6JamesGarlandMarketing7MaryLiuEngineering8LaraJacobsProduct9KentFergusonEngineeringColumn	A	in	the	above	table	indicates	whether	or	not
some	action	needs	to	be	taken	for	each	row.	One	approach	could	be	to	enter	"Y"	to	indicate	the	rows	that	should	be	processed.1Take	action?First	nameLast
nameDepartment2BenRamFinance3YJaneRyanFinance4AprilMadisonMarketing5JakeWoodSales6YJamesGarlandMarketing7MaryLiuEngineering8LaraJacobsProduct9KentFergusonEngineeringThis	can	be	made	seamless	by	using	checkboxes.	When	the	checkbox	in	a	row	is	checked,	it	indicates	that	the	script	should	process	that	row.There	is	SO	much
that	you	can	do	with	checkboxes	to	add	interactivity	to	your	Google	Sheet.	In	this	tutorial	we	will	explore	one	use	case,	and	in	subsequent	tutorials	(like	this	one)	we	will	explore	many	more.PrerequisitesThis	tutorial	assumes	that	you	are	familiar	with	the	basics	of	Google	Sheets:What	you	will	learn	in	this	tutorialThis	tutorial	covers	the	following
topics:How	to	insert	checkboxes	into	a	Google	Sheets	spreadsheet?To	insert	checkboxes	manually,	first	select	the	range	and	then	select	Insert	—>	Checkbox	from	the	menu.You	should	now	see	checkboxes	in	the	range	that	you	selected.A	checkbox	in	Google	Sheets	is	just	a	data	validation	with	two	states:	Checked	and	Unchecked	Your	browser	does
not	support	HTML5	video.	Here	is	a	link	to	the	video	instead.	A	checkbox	in	Google	Sheets	is	implemented	behind	the	scenes	as	a	data	validation.	When	you	insert	a	checkbox	in	a	cell,	that	cell	can	take	on	one	of	two	values.	By	default,	the	value	will	be	TRUE	when	the	checkbox	is	checked	and	FALSE	when	it	is	unchecked.Below	is	a	screenshot	that
shows	the	value	in	cell	A4	to	be	TRUE	because	the	checkbox	is	checked.In	fact,	since	a	checkbox	is	implemented	as	a	data	validation,	you	can	also	insert	a	checkbox	by	adding	validation	to	a	range.To	try	this,	first	select	the	range,	then	select	Data	—>	Data	validation.Choose	Checkbox	as	the	criteria	type	and	select	Save.You	should	now	see
checkboxes	in	the	range	that	you	selected.Assigning	custom	values	to	the	checked	and	unchecked	states	of	a	checkbox	in	Google	SheetsBy	default,	the	checked	and	unchecked	values	of	a	checkbox	are	set	to	TRUE	and	FALSE	respectively.	However,	you	can	override	this	and	set	custom	values	for	both	states.	Your	browser	does	not	support	HTML5
video.	Here	is	a	link	to	the	video	instead.	To	do	this,	select	the	Use	custom	cell	values	checkbox	when	setting	up	the	data	validation	and	enter	the	values	for	the	two	states.	In	the	screenshot	below,	I	entered	"Yes"	for	the	checked	state	and	"No"	for	the	unchecked	state.The	cell	A4	in	the	screenshot	below	is	set	to	the	value	Yes	(instead	of	TRUE)	since
the	checkbox	in	that	cell	is	checked.Building	a	To	Do	list	application	in	Google	Sheets	by	using	checkboxes	and	conditional	formatting	Google	Sheets	constantly	amazes	me	since	you	can	build	so	many	useful	applications	Step	1	—	Create	a	spreadsheet	with	two	columns:	status	and	taskIn	the	spreadsheet	below,	I'm	using	column	A	for	recording	the
status	of	a	task	and	column	B	for	a	description	of	the	task.Step	2	—	Add	data	validation	to	the	status	columnThe	next	step	is	to	insert	checkboxes	into	the	spreadsheet	in	column	A.Select	column	A	starting	with	cell	A2	(not	A1	since	you	don't	want	a	checkbox	inserted	into	the	header	row).Then	select	Data	—>	Data	validation	from	the	menu.Then	edit
the	Cell	range	to	ensure	the	range	is	A2:A	(notice	that	there	is	no	row	number	at	the	end).	This	will	ensure	that	the	data	validation	is	automatically	applied	to	any	new	rows	that	you	insert	into	your	spreadsheet.Select	Checkbox	as	the	criteria.Select	Use	custom	cell	values	and	add	Done	for	the	Checked	state	and	Not	done	for	the	Unchecked
state.Select	Save	to	add	the	validation.You	should	now	see	checkboxes	in	column	A.Step	3	—	Add	conditional	formatting	to	your	spreadsheetThe	final	step	to	complete	the	To	Do	application	is	to	add	conditional	formatting	to	mark	tasks	as	Done	when	the	checkbox	is	selected.First,	select	all	the	rows	other	than	the	header	row	in	your	spreadsheet.Then
select	Fill	color	from	the	toolbar	and	select	Conditional	formatting.Enter	the	range	the	formatting	should	be	applied	to	as	A2:B	(notice	there	is	no	row	number	at	the	end).Select	Custom	formula	as	the	formatting	condition	and	enter	=$A2="Done"	as	the	custom	formula.Select	the	formatting	style	for	your	completed	tasks.	I	chose	to	highlight
completed	rows	in	green	with	dark	gray	text	that	is	crossed.	Somehow,	seeing	a	To	Do	crossed	out	gives	me	extra	joy	 !!Finally,	select	Done	to	add	the	conditional	formatting	to	the	range.When	you	select	Done,	you	should	see	a	summary	of	the	conditional	formatting	rule	that	you	specified	in	the	sidebar.Now	whenever	you	mark	a	task	as	done,	you
should	see	the	row's	formatting	update	per	the	conditional	formatting	rule	you	specified.That's	it!	In	just	a	few	minutes	you	built	a	simple	To	Do	application	using	Google	Sheets.	Isn't	that	awesome?ConclusionIn	this	tutorial,	you	learned	how	to	use	checkboxes	in	Google	Sheets.	You	also	learned	how	to	build	a	simple	To	Do	list	application	using	just
checkboxes	and	some	conditional	formatting.If	you	enjoyed	this	tutorial	and	you	want	to	learn	more,	I've	got	you	covered!	Please	check	out	my	tutorial	on	how	to	work	with	checkboxes	in	Google	Sheets	using	Google	Apps	Script.Thanks	for	reading!	Your	feedback	helps	me	create	better	content	DISCLAIMER:	This	content	is	provided	for	educational
purposes	only.	All	code,	templates,	and	information	should	be	thoroughly	reviewed	and	tested	before	use.	Use	at	your	own	risk.	Full	Terms	of	Service	apply.	Join	1,500+	professionals	who	are	supercharging	their	productivity	with	Google	Sheets	automation	Exclusive	Google	Sheets	automation	tutorials	and	hands-on	exercises	Ready-to-use	scripts	and
templates	that	transform	hours	of	manual	work	into	seconds	Email	updates	with	new	automation	tips	and	time-saving	workflows	By	subscribing,	you	agree	to	our	Privacy	Policy	and	Terms	of	Service	Last	Updated	on	November	2,	2023	by	Jake	Sheridan	In	this	tutorial,	you	will	learn	how	to	use	conditional	formatting	with	a	checkbox	in	Google	Sheets
Google	Sheets	makes	it	easy	to	format	your	data	based	on	certain	conditions,	using	what	is	called	conditional	formatting.	This	feature	can	be	a	great	way	to	visualize	your	data,	and	make	it	more	interactive.	One	use	case	for	conditional	formatting	is	to	highlight	cells	that	contain	a	checkbox.	This	can	be	helpful	if	you	want	to	quickly	see	which	items	in
your	list	are	checked	off,	for	example.	In	this	guide,	we	will	show	you	how	to	use	conditional	formatting	with	a	checkbox	in	Google	Sheets.	Here’s	how	to	apply	conditional	formatting	based	on	a	checkbox	in	Google	Sheets.	First,	select	the	range	where	you	would	like	to	add	conditional	formatting	to.	In	this	example,	we’ll	want	to	highlight	columns	A	to
G	when	the	checkbox	in	column	G	is	checked	by	the	user.	Next,	click	on	the	Conditional	formatting	option	under	the	Format	drop-down	list.	Click	on	the	drop-down	list	under	Format	rules	to	explore	other	options.	Click	on	the	option	labeled	‘Custom	formula	is’.	This	option	enables	us	to	specify	a	custom	Google	Sheets	formula	as	a	rule	for	conditional
formatting.	We’ll	set	‘=$G2=TRUE’	as	our	custom	formula.	Since	we’ve	added	a	‘$’	symbol	next	to	the	letter	G,	the	formula	will	only	look	at	that	column	to	determine	whether	to	highlight	the	cell.	After	typing	the	formula,	you	may	now	specify	how	cells	should	be	highlighted	when	conditions	are	met.	Click	the	‘Done’	button	to	proceed.	You	should	now
have	a	table	with	highlights	cells	when	the	user	checks	the	checkbox	element.	This	guide	should	be	everything	you	need	to	use	conditional	formatting	with	a	checkbox	in	Google	Sheets	You	may	make	a	copy	of	this	example	spreadsheet	to	test	it	out	on	your	own.	Now,	you	might	be	wondering,	“Why	would	I	want	to	conditionally	format	checkboxes	in
the	first	place?”	Well,	there	are	a	few	good	reasons,	and	they’re	all	about	making	your	data	easier	to	interpret	at	a	glance.	Firstly,	conditional	formatting	with	checkboxes	can	help	visualize	progress.	Imagine	you’re	managing	a	project	and	tracking	tasks	using	a	checklist.	By	applying	conditional	formatting,	you	can	quickly	see	which	tasks	are
completed	and	which	are	still	pending.	A	green	background	for	completed	tasks,	for	example,	can	make	it	instantly	clear	what’s	done	and	what’s	not.	Secondly,	conditional	formatting	can	help	highlight	priorities.	If	you’re	dealing	with	a	list	that	has	varying	levels	of	importance,	you	can	format	the	checkboxes	to	reflect	these	priorities.	Maybe	a	critical
task	turns	red	when	unchecked,	signaling	urgency,	and	turns	green	when	completed.	It’s	like	having	a	built-in	reminder	system.	Lastly,	it’s	just	plain	satisfying.	There’s	something	delightful	about	watching	your	spreadsheet	transform	as	you	interact	with	it.	It	keeps	everything	neat,	organized,	and	visually	appealing,	making	your	data	not	just
informative	but	also	enjoyable	to	work	with.	Before	we	can	apply	any	fancy	formatting,	we	need	to	get	our	checkboxes	set	up.	If	you’ve	already	got	this	part	down,	feel	free	to	skip	ahead.	But	if	you’re	new	to	checkboxes	or	want	a	quick	refresher,	here’s	how	you	add	them	to	your	Google	Sheet.	First,	select	the	cells	where	you	want	to	insert
checkboxes.	You	can	select	multiple	cells	at	once,	which	is	handy	if	you’re	setting	up	a	list.	Next,	go	to	the	Insert	menu	and	choose	Checkbox.	Boom!	You’ve	got	checkboxes.	These	checkboxes	will	default	to	unchecked,	which	Google	Sheets	treats	as	FALSE.	When	you	check	a	box,	it	changes	to	TRUE.	It’s	a	simple	but	powerful	feature	when	combined
with	conditional	formatting.	Now	that	we’ve	got	our	checkboxes	ready,	let’s	move	on	to	the	fun	part—making	them	dynamic	with	conditional	formatting.	Alright,	let’s	get	into	the	nitty-gritty	of	applying	conditional	formatting	to	our	checkboxes.	The	process	is	pretty	straightforward,	but	I’ll	walk	you	through	it	step	by	step	to	make	sure	everything’s
clear.	First,	select	the	range	of	cells	containing	your	checkboxes.	Then,	go	to	the	Format	menu	and	choose	Conditional	formatting.	You’ll	see	a	sidebar	pop	up	on	the	right	of	your	Google	Sheet.	This	is	where	all	the	magic	happens.	In	the	sidebar,	you’ll	notice	an	option	to	add	a	new	rule.	Click	on	that,	and	you’ll	be	able	to	set	the	condition	that	triggers
your	formatting.	Since	we’re	dealing	with	checkboxes,	set	the	condition	to	“Custom	formula	is.”	Now,	in	the	formula	field,	type	=A1=TRUE,	assuming	A1	is	the	first	cell	in	your	selected	range.	This	formula	tells	Google	Sheets	to	apply	the	formatting	when	the	checkbox	is	checked	(TRUE).	With	the	condition	set,	it’s	time	to	choose	the	formatting	style.
This	is	where	you	can	get	creative.	Maybe	you	want	the	text	to	turn	green,	the	background	to	change	color,	or	the	font	to	become	bold.	Whatever	you	choose,	make	sure	it	serves	the	purpose	of	making	your	data	clearer	and	more	impactful.	Once	you’re	happy	with	the	formatting	style,	click	Done.	And	there	you	have	it!	Your	checkboxes	should	now
change	according	to	the	conditional	formatting	rule	you’ve	set.	Try	it	out	by	checking	and	unchecking	a	box	to	see	the	effect	in	action.	One	practical	application	of	conditional	formatting	for	checkboxes	is	task	management.	Let’s	say	you’ve	got	a	list	of	tasks	you	need	to	complete	for	a	project.	You	can	use	checkboxes	to	track	what’s	done	and	what	still
needs	attention.	Imagine	a	simple	task	list	with	tasks	in	column	A	and	checkboxes	in	column	B.	You	can	apply	a	conditional	formatting	rule	to	the	checkboxes	so	that	when	a	task	is	completed	(box	is	checked),	the	corresponding	row	changes	color.	This	visual	cue	can	help	you	quickly	assess	your	progress.	To	set	this	up,	select	your	range	of
checkboxes,	and	in	the	conditional	formatting	sidebar,	set	the	custom	formula	to	=B1=TRUE.	Choose	a	format	that	makes	the	completed	tasks	stand	out,	like	a	light	green	background.	With	this	setup,	as	you	check	off	tasks,	the	entire	row	can	change	color,	giving	you	a	clear,	visual	representation	of	what’s	been	accomplished	and	what’s	left.	Using
this	method,	you	can	transform	a	basic	to-do	list	into	a	dynamic	task	manager,	making	it	easier	to	stay	organized	and	on	top	of	your	work.	Another	fantastic	use	for	conditional	formatting	with	checkboxes	is	highlighting	priorities.	Let’s	say	you’re	managing	a	list	of	tasks	with	varying	levels	of	importance.	Some	tasks	are	urgent,	while	others	can	wait.
By	using	conditional	formatting,	you	can	easily	identify	which	tasks	need	your	immediate	attention.	For	instance,	you	could	have	a	column	for	urgency	where	you	use	checkboxes	to	mark	tasks	as	urgent.	You	can	then	apply	conditional	formatting	to	highlight	these	tasks.	When	a	task	is	marked	as	urgent,	the	text	or	background	color	could	change	to
red,	signaling	that	it	requires	prompt	action.	To	set	this	up,	select	the	cells	with	your	checkboxes,	and	in	the	conditional	formatting	sidebar,	use	the	custom	formula	=C1=TRUE,	assuming	C	is	your	urgency	column.	Choose	a	bold	format,	perhaps	with	a	red	background,	to	make	these	tasks	stand	out.	This	way,	even	at	a	quick	glance,	you’ll	know
exactly	where	to	focus	your	efforts.	This	approach	is	particularly	useful	in	busy	work	environments	where	priorities	can	shift	quickly.	By	visualizing	urgency,	you	can	adapt	more	easily	and	ensure	nothing	critical	slips	through	the	cracks.	Did	you	know?	Coefficient	eliminates	the	need	to	export	data	manually	and	rebuild	stale	dashboards.	Get	started
by	pulling	live	data	into	pre-built	Sheets	dashboards.	This	simple	Google	sheets	add	checkbox	tool	is	a	game	changer.		Using	checkboxes	in	Google	Sheets	can	help	users	stay	organized	and	on	top	of	their	tasks.	Whether	it’s	for	personal	use	or	for	a	team	project,	the	checkbox	feature	is	a	simple	yet	effective	way	to	keep	track	of	progress	and	ensure
that	nothing	falls	through	the	cracks.	To	add	a	checkbox	in	Google	Sheets,	users	can	follow	these	simple	steps:	Select	the	cell	where	the	checkbox	will	be	inserted.	Click	on	the	“Insert”	menu	and	select	“Checkbox.”	A	checkbox	will	appear	in	the	selected	cell.	Users	can	also	add	multiple	checkboxes	at	once	by:		Selecting	a	range	of	cells	and	following
the	same	steps	Once	the	checkboxes	have	been	added,	users	can	customize	their	appearance	and	behavior	by	using	the	“Checkbox”	option	in	the	“Data	validation”	menu.	Google	Sheets	checkboxes	are	not	just	for	simple	task	tracking.	They	can	be	used	for	a	variety	of	advanced	purposes	with	the	help	of	formulas.	Here	are	some	techniques	for	using
checkbox	formulas	in	Google	Sheets:	To	count	checked	boxes	in	a	range	using	Google	Sheets,	follow	these	steps:	1.	Identify	the	Range:	Select	the	cells	with	checkboxes,	e.g.,	A1	to	A10.	2.	Use	COUNTIF:	Enter	=COUNTIF(A1:A10,	TRUE)	in	a	separate	cell.	This	formula	counts	how	many	boxes	are	checked	(marked	as	TRUE)	in	the	specified	range.	It’s
a	straightforward	method	for	summarizing	checkbox	responses.	Conditional	formatting	is	a	powerful	tool	that	allows	users	to	change	the	appearance	of	cells	based	on	certain	conditions.	In	the	case	of	Google	Sheets	Checkbox,	users	can	use	conditional	formatting	to	customize	the	appearance	of	the	checkbox	based	on	its	state	(checked	or	unchecked).
To	use	conditional	formatting	with	Google	Sheets	Checkbox,	users	can	follow	these	steps:	Select	the	cell	or	range	of	cells	with	the	checkbox(es).	Click	on	the	“Format”	menu	and	select	“Conditional	formatting.”	In	the	“Format	cells	if”	drop-down	menu,	select	“Custom	formula	is.”	In	the	“Value	or	formula”	field,	enter	the	formula	“=A1=TRUE”	(replace
“A1”	with	the	cell	reference	of	the	checkbox).	Choose	the	formatting	options	for	the	checked	state	of	the	checkbox	(e.g.	change	the	background	color	to	green).	Click	“Done”	to	apply	the	formatting.	Users	can	repeat	these	steps	to	customize	the	appearance	of	the	checkbox	for	the	unchecked	state	(using	the	formula	“=A1=FALSE”	instead).	Checkbox
formulas	can	be	used	in	other	formulas	to	perform	calculations	or	return	values	based	on	the	status	of	a	checkbox.	For	example,	to	sum	a	range	of	cells	only	when	corresponding	checkboxes	are	checked:	1.	Use	SUMIF:	Apply	=SUMIF(A1:A10,	TRUE,	B1:B10).	2.	How	it	Works:	This	sums	values	in	B1:B10	only	if	checkboxes	in	A1:A10	are	checked.	As
you	can	see,	there	are	many	ways	to	take	advantage	of	checkbox	formulas	depending	on	your	specific	use	case.	Remembering	all	of	these	formulas	in	one	go	can	be	a	bit	overwhelming.	However,	there	are	GPT	add-ons	for	Google	Sheets	like	Coefficient	that	you	can	use	to	generate	formulas,	pivots,	and	charts!	Installing	Coefficient’s	Google	Sheets
extension	is	super	quick	and	you	can	get	started	for	free	right	from	our	website.	Once	you	submit	your	email,	you’ll	see	a	big	blue	button	on	the	sheet	you’re	provided	that	will	install	the	add-on.	Once	the	installation	is	finished,	return	to	Extensions	on	the	Google	Sheets	menu.	Coefficient	will	be	available	as	an	add-on.	Free	AI-Powered	Tools	Right
Within	Your	Spreadsheet	Supercharge	your	spreadsheets	with	GPT-powered	AI	tools	for	building	formulas,	charts,	pivots,	SQL	and	more.	Simple	prompts	for	automatic	generation.	Now	launch	the	app.	Coefficient	will	run	on	the	sidebar	of	your	Google	Sheet.	Select	GPT	Copilot	on	the	Coefficient	sidebar.	Then	click	Formula	Builder.	Type	a	description
of	a	formula	into	the	text	box.	For	this	example,	I	will	calculate	the	sum	the	closed	won	deals	to	keep	this	information	constantly	updated	on	my	report.	Let’s	type:	Sums	values	in	A2:B9	in	Sheet4	only	if	checkboxes	in	B2:B9	are	checked.	Then	press	‘Build’.	Formula	Builder	will	automatically	generate	the	formula	from	the	first	example.	You’ll	simply
copy	your	formula	over	to	the	cell	you’d	like	to	place	your	Closed	Won	deal	value.	Checkbox	formulas	allow	for	advanced	calculations	and	conditional	formatting,	streamlining	data	analysis	and	management.	In	conclusion,	using	the	checkbox	tool	and	formulas	in	Google	Sheets	can	greatly	enhance	the	functionality	of	your	spreadsheets.	With	these
advanced	techniques,	you	can	count	checked	boxes,	apply	conditional	formatting,	and	use	checkbox	formulas	in	other	formulas	to	perform	complex	calculations.	Bonus,	you	can	do	so	even	faster	with	Coefficient’s	GPT	formula	builder.	This	tutorial	demonstrates	how	to	use	conditional	formatting	with	a	checkbox	control	in	Excel	and	Google	Sheets.	►
Click	here	to	jump	to	the	Google	Sheets	walkthrough.	Conditional	Formatting	With	Checkbox	About	Linked	Checkboxes	In	Excel,	you	can	use	a	checkbox	to	control	whether	a	conditional	formatting	rule	is	applied.	For	the	following	example,	you	have	the	data	below	in	Column	B	and	a	checkbox	for	each	name	in	Column	C.	Each	checkbox	must	be
linked	to	a	cell	in	Column	D.	When	you	click	a	checkbox	that	is	linked	to	a	cell,	the	value	in	the	cell	changes	to	either	TRUE	or	FALSE.	If	you	do	not	want	to	see	the	TRUE	/	FALSE	values,	change	the	font	color	to	white.	Now,	say	you	want	the	background	color	of	a	name	in	Column	B	depending	on	whether	it’s	checked	(i.e.,	the	value	is	TRUE).	Change
Cell	Color	With	Checkbox	Create	a	conditional	formatting	rule	for	the	range	containing	the	names	(B3:B10)	to	add	a	fill	color	to	a	cell	when	its	checkbox	is	checked.	Since	the	first	checkbox	is	linked	to	cell	D2,	this	cell’s	value	is	TRUE	if	the	checkbox	is	checked,	and	FALSE	if	it’s	unchecked.	You’ll	use	the	value	of	cell	D2	as	the	determinant	for	the
conditional	formatting	rule.	Select	the	list	of	names	and	then,	in	the	Ribbon,	go	to	Home	>	Conditional	Formatting	>	New	Rule.	From	the	Rule	Type	list,	(1)	choose	Use	a	formula	to	determine	which	cells	to	format.	This	gives	you	a	formula	box	under	Edit	the	Rule	Description.	(2)	In	the	box,	enter:	=$D3=TRUE	Ensure	that	the	$	is	only	on	the	column
reference	and	not	on	the	row	reference.	This	is	known	as	a	mixed	reference.	Then	(3)	click	Format.	In	the	Format	Cells	window,	choose	a	color	(e.g.,	light	blue)	and	click	OK.	That	takes	you	back	to	the	New	Formatting	Rule	window.	Click	OK.	Now,	when	you	check	the	box	next	to	each	name,	that	name	cell’s	background	turns	light	blue.	Note:	Also
learn	about	using	checkboxes	with	VBA.	Conditional	Formatting	With	Checkbox	in	Google	Sheets	The	process	is	similar	in	Google	Sheets.	Insert	a	checkbox	next	to	each	name	in	your	Google	Sheet.	You	do	not	have	to	associate	a	checkbox	in	Google	Sheets	with	a	cell;	linking	happens	automatically.	Select	the	data	range	and	in	the	Menu,	go	to
Format	>	Conditional	formatting.	In	the	Conditional	format	rules	window	on	the	right,	(1)	choose	Custom	formula	is	and	(2)	enter	the	formula:	=$C3=TRUE	Note	that,	unlike	in	Excel,	this	formula	references	the	cell	containing	the	checkbox.	For	the	Formatting	style,	(3)	click	Fill	color,	(4)	choose	the	background	color	(i.e.,	light	blue),	and	(5)	click
Done.	As	in	Excel,	when	you	check	the	box	next	to	each	name,	that	name	cell’s	background	turns	light	blue.	Today,	we	will	look	at	how	we	can	use	Conditional	Formatting	with	a	Checkbox	in	Google	Sheets.	Conditional	Formatting	and	Checkboxes	are	widely	used	in	this	application	individually,	but	combining	them	both	brings	in	a	new	dimension	of
spreadsheet	customizability.	In	this	article,	we’ll	see	3	suitable	examples	to	use	Checkbox	with	Conditional	Formatting	in	Google	Sheets	with	clear	images	and	steps.	At	last,	you’ll	get	an	output	like	the	below	image.	A	Sample	of	Practice	Spreadsheet	You	can	download	Google	Sheets	from	here	and	practice	very	quickly.	Conditional	Formatting	with
Checkbox	How	to	Insert	Checkbox	in	Google	Sheets	Let’s	start	with	the	fundamentals,	that	is	to	insert	a	Checkbox	in	Google	Sheets.	But	if	it	is	too	trivial	for	you,	please	feel	free	to	jump	to	the	examples	section	to	see	how	we	can	use	Checkboxes	with	Conditional	Formatting	in	Google	sheets.	We	have	the	following	dataset	where	we	have	some
weekend	chores	in	Column	B.	Now,	we	want	to	insert	Checkboxes	in	Column	C	beside	every	chore.	Steps:	Firstly,	select	the	cells	you	want	to	insert	the	Checkbox	You	can	also	select	a	range	of	cells.	Here	the	range	is	from	Cell	C5	to	Cell	C9.	Secondly,	navigate	to	the	Insert	tab	and	select	the	Checkbox	option.	And,	you	can	see	the	Checkboxes	in
Column	C.	At	its	base,	Checkboxes	are	no	different	from	Boolean	outcomes	of	TRUE	and	FALSE,	and	Googles	Sheets	views	them	as	such	when	operating	with	them.	A	simple	check	will	prove	this.	Now,	we	will	display	the	result	of	the	Checkbox	in	Column	D	by	writing	a	simple	formula	in	Cell	D5:	After	that,	apply	the	Fill	Handle	tool	to	use	the	formula
in	the	rest	of	the	cells	of	Column	D.	Then,	you’ll	see	the	Boolean	outcomes	in	all	the	cells	of	Column	D.	Finally,	when	the	box	is	not	checked	the	result	is	FALSE	and	TRUE	when	the	box	is	checked.	We	will	use	this	understanding	later	when	creating	the	custom	formula	for	Conditional	Formatting.	Read	More:	How	to	Copy	Conditional	Formatting	in
Google	Sheets	Similar	Readings	3	Suitable	Examples	to	Use	Conditional	Formatting	with	Checkbox	in	Google	Sheets	Below	we’ll	see	3	suitable	examples	of	how	we	can	combine	Checkboxes	with	Conditional	Formatting	for	practical	use	in	Google	Sheets.	We’ll	use	some	custom	formulas	in	all	the	cases.	Example	1.	Creating	a	To-Do	List	First	of	all
we’ll	create	a	to-do	list	with	Checkboxes	and	apply	Conditional	Formatting	there.	The	Conditional	format	rules	in	Google	Sheets	do	not	have	any	built-in	conditions	that	directly	work	with	Checkboxes;	thus,	we	have	to	take	advantage	of	the	Custom	formula	is	option	under	the	Conditional	Formatting	menu.	Steps:	At	first,	activate	all	the	cells	from	Cell
B5	to	D9.	Then,	simply	navigate	to	the	Format	tab	and	select	the	Conditional	Formatting	option.	Here,	in	the	Conditional	format	rules	window	move	to	the	Format	rules	menu.	Next,	in	the	Format	cells	if…	drop-down	list,	find	the	Custom	formula	is	option	at	the	bottom.	After	that,	to	highlight	the	entire	row	with	our	primary	condition	being	the
Checkbox,	we	enter	the	following	custom	formula:	Consequently,	you	can	choose	your	own	formatting	style.	We	pick	the	green	color	to	format	our	dataset.	Then,	press	the	Done	button.	Further,	you’ll	see	the	to-do	list	with	Checkboxes	is	ready.	In	the	end,	when	you	check	the	box,	the	corresponding	row	will	highlight	with	green	color.	Read	More:
Google	Sheets:	Conditional	Formatting	Row	Based	on	Cell	Example	2.	Highlighting	Whole	Range	We	can	also	define	the	Checkbox	to	highlight	a	range	of	cells	at	once.	We	only	need	to	bring	a	slight	change	to	our	formula.	That	being,	locking	the	cell	reference	of	the	Checkbox.	For	our	example,	we	will	highlight	all	the	weekend	chores	in	Column	B	as
soon	as	the	box	is	checked.	Steps:	First	of	all,	select	all	the	cells	in	the	range	from	Cell	B5	to	B9	and	go	to	Format	>	Conditional	Formatting.	Then,	choose	the	Custom	formula	is	option	under	the	Format	rules	menu.	After	that,	write	the	following	custom	formula	in	the	formula	box:	Next,	choose	the	color	green	from	the	Color	option	and	click	the	Done
button.	Lastly,	all	the	values	will	be	highlighted	in	green	when	you	check	the	box.	Read	More:	Conditional	Formatting	Based	on	Another	Cell	in	Google	Sheets	Example	3.	Applying	Checkbox	with	Multiple	Conditional	Formatting	Now,	we’ll	apply	the	Checkbox	with	multiple	Conditional	Formatting.	Here,	we	have	a	dataset	that	contains	the	marks
obtained	by	some	students	of	two	different	subjects	in	Columns	C	and	D.	Notice	that	we	have	added	two	Checkboxes	to	determine	and	highlight	certain	results.	Our	first	condition	is	to	highlight	the	cells	that	contain	outstanding	results	(greater	than	90)	when	the	Checkbox	is	checked.	Our	second	condition	is	to	highlight	the	cells	that	contain	failing
results	(less	than	50)	when	the	Checkbox	is	checked.	For	these	purposes,	we’ll	use	the	AND	function	as	the	custom	formula	under	the	Conditional	Formatting	window.	This	function	gives	TRUE	when	all	the	conditions	are	TRUE	and	FALSE	when	any	of	the	conditions	is	FALSE.	Let’s	see	how	it’s	done.	Steps:	Before	all,	select	all	of	the	cells	in	the	range
from	Cell	C5	to	Cell	D9,	then	choose	Format	>	Conditional	Formatting.	Choose	Custom	formula	is	from	the	Format	rules	menu	after	that.	Thereafter,	fill	out	the	formula	box	with	the	following	unique	formula:	Then	select	green	from	the	Color	button	and	press	the	Done	button.	Now,	if	you	check	Cell	D11,	then	all	the	values	greater	than	90	of	your
dataset	will	highlight	with	green	color.	Again,	activate	all	of	the	cells	in	the	range	from	Cell	C5	to	Cell	D9.	Then,	go	to	Format	>	Conditional	Formatting.	Next,	click	on	the	Add	another	rule	option	at	the	bottom	of	the	Conditional	Formatting	rules	window	to	add	the	second	condition.	Moreover,	select	Custom	formula	is	from	the	Format	rules	option.
Then,	enter	the	following	custom	formula	in	the	formula	box:	Next,	choose	pink	from	the	Color	button,	and	then	click	the	Done	button.	Now	if	you	check	Cell	D12,	all	of	your	dataset’s	values	below	50	will	be	highlighted	in	pink.	Ultimately,	all	of	your	dataset’s	values	below	50	and	above	90	will	be	highlighted	in	pink	and	green,	respectively,	when	you
check	both	cells.	Read	More:	Conditional	Formatting	with	Multiple	Conditions	Using	Custom	Formulas	in	Google	Sheets	Final	Words	That	concludes	the	ways	we	can	use	Conditional	Formatting	with	Checkbox	in	Google	Sheets.	We	hope	our	discussion	comes	in	handy.	Please	feel	free	to	leave	any	queries	or	advice	you	might	have	for	us	in	the
comments	section	below.	You	will	also	find	different	articles	related	to	google	sheets	on	our	officewheel.com.	Visit	the	site	and	explore	more.	Related	Articles	PREMIUM	ACCESSSupport	the	site	by	becoming	a	Premium	member	and	enjoy	several	exclusive	options:Ad-free	NavigationNo	Tracking	ModeIncognito	Mode	(on	the	forum)Dark	Mode	To
activate	conditional	formatting	in	Google	Sheets	using	a	checkbox,	use	the	AND	function	to	add	the	reference	of	the	checkbox	cell.	Usage	Example	In	this	example,	a	conditional	formatting	should	display	the	top	5	highest	amounts	provided	that	the	checkbox	is	checked:	Start	by	selecting	the	cell	range	of	the	amounts,	add	a	conditional	formatting	and
choose	the	formatting	rule	"Custom	formula	is".	To	check	if	an	amount	is	among	the	top	5	in	the	range,	the	RANK	function	will	be	used	here:	=RANK(B2,$B$2:$G$6,0)	‘Custom	formula	is‘.	Enter	the	following	formula:	=$B2	(which	selects	all	of	the	checkbox	cells).	Specify	the	format	(color	and	the	strike-through	format).	2.	Highlighting	Data	with
Check	Box	Functionality	You	can	use	the	checkbox	to	make	your	reports	more	visually	appealing	and	easier	to	read.	In	this	example,	Google	Sheets	will	highlight	the	data	in	the	table	once	you	select	any	checkboxes:	This	example’s	conditional	formatting	is	dependent	on	the	value	of	the	cell	with	the	checkbox.	In	the	above	example,	if	I	select	the
checkbox	for	“>85”,	it	instantly	changes	the	color	of	the	cells	in	Column	B	that	are	greater	than	85.	Add	the	checkbox	(and	specify	the	criteria	for	it	as	text	in	the	adjacent	cell)	Select	the	cells	in	Column	B	(with	checkmarks).	Select	Format	>	Conditional	Formatting	>	Format	cells	if	Click	on	‘Custom	formula	is’	option	and	enter	the	following
formula:	=AND($E$3,B2>=85)	Specify	the	format	when	marks	are	more	than	85	(I’ve	used	green	in	my	example).	Click	Done.	Click	Add	New	Rule	>	Format	cells	if	>	Custom	formula	is	Enter	the	following	formula:	=AND($E$4,B2	Data	validation	Make	sure	the	value	in	the	Criteria	dropdown	menu	is	set	to	Checkbox	Check	the	“Use	custom	cell
values”	box.	input	the	values	you	prefer	(e.g.,	color,	font).	Click	“Save.”	How	to	Remove	Custom	Values	from	Checkboxes	To	remove	custom	values,	follow	the	same	steps	for	adding	them	–	but	uncheck	the	“Use	custom	values	box.”	Can	Google	Sheets	Add	a	Checkbox	in	the	Mobile	App?	Yes,	it’s	possible	to	use	Android	and	MacOS.	To	make	a	check
box	in	the	Google	Sheets	app:	Select	the	cells	you	want	to	add	checkboxes	to	Tap	the	three	dots	menu	Select	Data	validation	In	the	criteria	dropdown,	select	the	checkbox	option.	Note	that	Google’s	support	also	talks	about	adding	checkboxes	in	Google	Docs.	How	to	Copy	and	Delete	Google	Sheets	Checkboxes	Google	checkboxes	can	be	copied	and
pasted	like	any	other	regular	cell.	To	delete	a	checkbox	from	a	cell	(or	a	range	of	cells),	simply	select	the	cells	and	hit	the	Delete	key.	Note:	If	you	select	a	cell	that	has	a	Google	Sheets	checkbox	and	type	something	in	it,	the	new	text	will	replace	it.	Ideas	to	Format	Check	Boxes	in	Google	Sheets	Since	a	checkbox	is	a	part	of	the	cell,	you	can	format	it
just	like	any	other	cell.	For	example,	you	can	use	conditional	format	rules	to	apply	a	color	to	the	cell,	changing	the	checkbox	from	gray	to	the	color	of	your	choice.	You	can	also	change	the	font	in	case	you	want	bigger	checkboxes.	Say	that	you	have	a	list	of	tasks	with	checkboxes	in	adjacent	cells.	You	can	select	the	entire	range	and	sort	the	list
alphabetically.	This	will	also	sort	the	checkboxes	in	the	selected	range.	Frequently	Asked	Questions	As	always,	I’m	including	some	of	the	most	common	questions	I	hear	on	the	subject.	Please	take	a	look	and	let	me	know	in	the	comments	if	I	missed	anything!	What’s	the	Difference	Between	a	Checkmark	and	a	Checkbox?	There’s	a	slight	difference
between	a	checkmark	and	a	checkbox:	A	Google	Sheets	checkmark	is	a	symbol	inserted	as	text	within	cells.	It	doesn’t	have	any	interactivity	and	can	be	used	as	a	symbol	or	a	bullet	point.	A	checkbox	is	interactive	and	confined	to	a	cell.	In	Google	Sheets,	a	checkbox	cannot	have	any	text	before	or	after	it.	Can	You	Put	a	Checkbox	and	Text	in	the	Same
Cell	in	Google	Sheets?	No,	you	can’t.	A	tick	box	takes	up	the	entire	cells	and	basically	contains	a	value	of	TRUE	or	FALSE.	You	cannot	add	any	other	data	to	the	same	cell,	but	you	can	modify	your	formatting	to	make	it	look	like	there’s	text	in	the	same	cell.	How	Do	I	Tick	Multiple	Checkboxes	in	Google	Sheets?	Highlight	the	cells	and	press	the	space
bar	to	tick	or	untick	cells	in	bulk.	Can	You	Make	a	Checklist	in	Google	Sheets?	Yes,	once	you	have	a	list	of	items,	highlight	the	adjacent	cells	and	navigate	to	Insert	>	Checkbox	to	add	them.	How	Do	I	Use	Checkboxes	in	Conditional	Formatting?	Say	that	you	have	a	checkbox	in	B2	and	want	C2	to	highlight	green	when	the	checkbox	is	checked.	In	the
conditional	formatting	menu	for	C2,	set	the	rule	to	“Custom	formula	is”	and	use	the	formula	=$B2.	This	formatting	option	is	incredibly	handy	for	to-do	lists.	Can	You	Create	a	Select	All	Checkbox?	You	can	select	the	header	row	or	column	headers	containing	checkboxes	to	select	all	of	them	simultaneously.	If	you	want	to	highlight	several	rows	or
columns,	there’s	a	keyboard	shortcut:	Hold	Ctrl	(Cmd	on	macOS)	to	select	them.	Next,	check	or	uncheck	them	by	pressing	the	space	bar.	Can	You	Have	Multiple	Checkboxes	in	One	Cell	in	Google	Sheets?	No,	you	can’t	have	multiple	checkboxes	in	a	single	cell.	The	cell	must	be	able	to	return	a	single	TRUE	or	FALSE	value,	which	isn’t	possible	if	two
boxes	exist	in	a	single	cell.	Wrapping	up	A	Google	Sheets	checkbox	has	so	many	potential	uses	–	and	can	quickly	take	your	worksheets	and	spreadsheet	templates	to	the	next	level.	At	Spreadsheet	Point,	we’re	committed	to	building	your	skills.	Check	out	one	of	our	Google	Sheets	articles	to	get	started!	April	20,	2025In	this	article	we	will	show	you	how
to	apply	conditional	formatting	to	a	checkbox	and	how	we	can	use	this	to	create	data	that	is	more	user	friendly	and	responsive.When	Should	you	use	Conditional	Formatting	with	Checkboxes?Conditional	formatting	is	a	great	way	to	make	checkboxes	easier	to	understand.	As	an	example,	data	can	be	made	green	when	a	checkbox	is	checked	and	red
when	it	is	unchecked.How	to	use	Conditional	Format	on	a	Checkbox	CellFor	the	examples	in	this	article	a	sample	sheet	was	created,	follow	along	by	clicking	here	to	access	the	sample	sheet.ExampleStep	1:	Select	the	checkbox	cell	rangeSelect	the	range	of	checkbox	cells	to	be	included	in	the	conditional	format.Google	Sheets	conditional	formatting
checkbox​Step	2:	Select	Format	>	Conditional	formattingWith	the	range	highlighted	from	the	top	toolbar	select	Format,	then	select	Conditional	formatting	from	the	format	menu.Google	Sheets	conditional	formatting	checkbox:	Formatting	menuStep	3:	Change	the	format	rulesYou	will	now	see	a	pop	up	menu	appear	on	the	right	hand	side	called
Conditional	format	rules.Google	Sheets	conditional	formatting	checkbox:	Format	rules​In	the	Format	rules		select	the	drop	down	menu	labelled	“Format	cells	if…”	be	sure	to	change	this	from	Is	not	empty	to	Text	is	exactly.	This	will	show	a	new	Value	box	underneath	this	menu.	Enter	TRUE.	When	a	checkbox	cell	state	is	checked	the	cell	value	is	set	to
TRUE	and	FALSE	if	not	checked.	We	can	utilize	these	parameters.Google	Sheets	conditional	formatting	checkbox:	Rules	and	style​Next	change	the	cell	fill	color	to	your	desired	color	choice	using	the	color	fill	tool	in	the	Formatting	style	options.	Here	you	can	also	change	the	text	to	an	array	of	options	including	bold,	italic,	underlined,	strikethrough	or
text	color.	For	this	example	we	will	choose	the	cell	fill	color	to	Green.Google	Sheets	conditional	formatting	checkbox:	Color	fill​Step	4:	Select	Done	to	see	the	resultsSelect	Done	in	the	Conditional	format	rules,	this	will	now	apply	your	chosen	specifications.Google	Sheets	conditional	formatting	checkbox:	Results​How	to	use	conditional	formatting	with
checkboxes	in	Google	Sheets?Example:	Create	a	to-do	listIn	this	example	we	will	create	a	responsive	to-do	list.	​Step	1:	Select	the	data	rangeSelect	the	range	of	data	you	want	to	apply	the	conditional	formatting	to.	In	our	example	we	will	be	selecting	the	item	cells	but	we	can	include	the	full	row	by	highlighting	both	columns	at	this	step.​How	to	use
conditional	formatting	with	checkboxes	Google	Sheets​Step	2:	Select	Format	>	Conditional	formattingFrom	the	main	toolbar	select	Format	followed	by	Conditional	formattingHow	to	use	conditional	formatting	with	checkboxes	Google	Sheets:	Format	menu​Step	3:	Set	Format	rules	to	Custom	Formula	isA	menu	will	now	appear	to	the	right	called
Conditional	format	rules,	select	the	drop	down	menu	underneath	the	“format	cells	if	…”	label	in	Format	rules.	At	the	bottom	of	the	drop	down	menu	you	will	see	the	option	for	Custom	formula	is.	Click	on	this	option.How	to	use	conditional	formatting	with	checkboxes	Google	Sheets:	Custom	formula​Step	4:	Enter	the	custom	formula	and	formatting
styleWhen	the	Custom	formula	is	selected,	a	new	input	box	will	appear	below	prompting	for	a	value	or	formula,	enter	the	formula:=$	followed	by	the	first	checkbox	cell.	This	will	apply	to	the	other	cells	in	the	column.​For	our	example	this	will	be	=$G4We	are	then	able	to	format	the	style	of	the	text.	We	will	apply	the	Strike-through	format	to	our
text.How	to	use	conditional	formatting	with	checkboxes	Google	Sheets:	StyleStep	5:	Select	done	to	see	your	resultsSelect	Done,	you	can	now	test	the	results	and	see	that	when	checkbox	status	is	set	to	checked	the	item	cell	fills	in	green	and	the	text	the	strike-through	is	applied.How	to	use	conditional	formatting	with	checkboxes	Google	Sheets:
ResultsConclusionIn	this	article,	we	have	demonstrated	different	ways	in	which	we	can	apply	conditional	formats	to	checkboxes	to	make	spreadsheets	more	dynamic	and	responsive.	​Related	ArticleGoogle	Sheets	Compound	Interest	Formula	(2025	Guide)


